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A11 Prime

1. Manual Information

This Windows Driver Installation Manual provides information on installation, detailed
specifications, and usage of the printer’s Windows Driver according to PC operating system (OS).

We at POSBANK maintain ongoing efforts to enhance and upgrade the functions and
quality of all our products. In following, product specifications and/or user manual content
may be changed without prior notice.

2. Operating System (OS) Environment
The following operating systems are supported by this Windows driver.

Microsoft® Windows XP SP3 (32bit)

Microsoft® Windows XP SP1 or later (64bit)

Microsoft Windows Server 2003 SP1 or later (32bit/64bit)
Microsoft Windows VISTA (32bit/64bit)

Microsoft Windows Server 2008 (32bit/64bit)

Microsoft Windows Server 2008R2 (64bit)

Microsoft Windows 7 (32bit/64bit)

Microsoft Windows 8 (32bit/64bit)

Microsoft Windows Server 2012 (64bit)

Microsoft Windows 10 (32bit/64bit)

* Serial and Bluetooth printer ports do not work on Windows 10 version 1511 (OS Build
105860.104) specific. We recommend you to install the latest Windows 10 update through

Windows Update before installing Windows Driver.

You can download and install the Windows Update in the Update & security tab of the
Settings menu (& > Settings > Update & security > Windows Update).

3. Windows Driver Preparation

The Windows Driver is included in the enclosed CD, and latest file versions can be downloaded
from the POSBANK website. (www.posbank.com)

POSBANK"
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4. Windows Driver Installation

4-1 Installing on Windows XP / Server 2003

4-1-1 Via Serial Port or Bluetooth
1) Double-click the Windows Driver installation file.

2) Click Next.

POSBAMNK PBA11 Prime Windows Driver Installation

Welcome to the InstallShield Wizard for POSBANK PB-A11 Prime Windows Driver

will install POSBAME PE-A11 Prime Wi r on your computer, To

InstallShield I < Back H 1 Cancel
3) Select a COM port to be used, and then click Next.
Port Type |Z|

Serial Port / Blustooth Serial Port
®icoMi Ocoma (OcomM7 (Qcomio (O cComi3 (O COM16
Ocom2 (Ocoms (Qcoms  Ocomir O comida O cComiz
Ocom3  Ocome (Ocome  Ocomiz (O comis (O CoMis

USB Port
O uss

Ethernet / Wireless LAN
() Ethernet / Wireless LAN
IP Address: | 192 . 168 . 1 1|

Port Number :

MNext

POSBANK®



A11 Prime
4) Click Yes to reboot the PC.

Restarting wour computer can kake effect,

.? h
\f{} Flease restark wour computer,

['fes] I wank ko reskart my computer now,
[Mo] I will reskart my compuker later,

Yes o

5) Open the printer properties window in the Windows OS.
* Control Panel — Printers and Faxes.

6) In the Ports tab, click Configure Port.
% Skip this step in case of data communication using Bluetooth.

7) Match the communication settings to those of the printer. The communication settings of the
printer can be performed by conducting a self-test.
% Skip this step in case of data communication using Bluetooth.

COM1 Properties

FPort Settings |

Bitz per second: | 115200

Data bits: g v|
Parity: | None v|

Stap bits: |1 |
Flow control: | Hardware v|

[ Resztare Defaultz ]

] ] [ Cancel ] Apply

POSBANK"
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8) Click Print Test Page and check printing status. Proper installation of the driver is indicated if
the test page is printed normally.

& pB-A11P Miniprinter Properties

General | Sharing || Ports || &dvanced || Color M anagement !i Language || YWersion |

E‘gg |PB-m 1P Minipririter |

Locatian: | |

Comment;

b odel; FEB-A11P Miniprinter

Features

Color: Yes Faper available:
Double-zided: Mo a0 « 3276 mmla11PRM]
Staple: Mo

Speed: Unknown

b airiurn rezolution: 180 dpi

Frinting F'referenu:es...] | Frint Test Page ,I

] ] [ Cancel Apply

POSBANK®



4-1-2 Via USB Port

1) Double-click the Windows Driver installation file.

2) Click Next.

POSBAMNK PBA11 Prime Windows Driver Installation

Welcome to the InstallShield Wizard for POSBANK PB-A11 Prime Windows Driver

Inistenl Shield

will install POSBAMNK PB-A11 Prime

A11 Prime

on your computer, To

3) Select USB and then click Next.

Port Type
Serial Port / Blustooth Serial Port
) CcomM1 () coma () Ccom7 O comio O comiz (O CoMmia
) coM2 () CoMs () coms OcoMmil O comia O CoMiz
) CoM3 () COMEG ) coma Ocomiz O comis O cComis
USBE Port
Ethernet / Wireless LAN
() Ethernet / Wireless LAN
IP Address : | 192 . 168 1|
Port Number :
MNext

X

POSBANK®



A11 Prime
4) Click OK.

%]

- | J Please turn-off the printer and then turn-on again,

2k

5) Turn off the printer and then turn it on. The printer driver will be installed automatically.

6) Open the printer properties window in the Windows OS.
* Control Panel — Printers and Faxes.

7) Click Print Test Page and check printing status. Proper installation of the driver is indicated if
the test page is printed normally.

& pB-A11P Miniprinter Properties E| |g|

General | Sharing || Ports | Advanced fi.EDIDr Managemen.t. -Language I Version |

[t
@ |F'B-M1F' Minipriiter |

Locatian: | |

Comment;

b odel; FEB-A11P Miniprinter

Features

Color: Yes Faper available:
Double-zided: Mo a0 « 3276 mmla11PRM]
Staple: Mo

Speed: Unknown

b airiurn rezolution: 180 dpi

Frinting F'referenu:es...] | Frint Test Page ,I

] ] [ Cancel Apply

POSBANK"



A11 Prime
4-1-3 Ethernet / Wireless LAN Port

1) Double-click the Windows Driver installation file.

2) Click Next.

POSBANK PBA11 Prime Windows Driver Installation

Welcome to the Installshield Wizard for POSBANK PB-A11 Prime Windows Driver

ompuker. To

Inasteal IShield . < Back H 1 Cancel
3) Select Ethernet /[ Wireless LAN.
4) Enter the IP address and port number, and then click Next.
Port Type |Z|

Serial Port / Bluetooth Serial Port

Ocomi Qcoma (Qcomz  Qcomio Qcomiz O COMI16
OcoM2z Ocoms  (Ocoms  (QcoMil QcoMid O COM17
OcoM3 Ocome (O coMe (O coMmi2 O CoMis (O COM1s

USB Port
QO usB

Ethernet / Wireless LAN
® Ethermnet / Wireless LAN

IP Address : | 192 . 168 . 1 . 1 |

Port Number :

MNext

POSBANK®



5) Click Yes to reboot the PC.

2

Restarting wour computer can kake effect,
Flease restart wour computer,

[fes] I want ko reskart my compuker now,
[Mo] I will restart my computer later,

Yes Mo

6) Open the printer properties window in the Windows OS.
#* Control Panel — Printers and Faxes.

7) In the Ports tab, click Configure Port....

8) Match the communication settings to those of the printer.
#* The “LPR” protocol is not supported with this printer.

Configure Standard TCP/IP Port Monitor,

Puart Settingz |

Part Mame:
Protocal

R aw Settingz
Part Murnber:

LPR Settings

[ 1 5MMP Status Enabled

|IF'_1E|2.1EE.1.1

Prirter Mame or [P Address: | 19216811

(%) Raw C)LPR

|91nu

LFPR Bute Counting Enabled

| OK

|[ Cancel ]

POSBANK"
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9) Click Print Test Page and check printing status. Proper installation of the driver is indicated if
the test page is printed normally.

& pB-A11P Miniprinter Properties

General | Sharing || Ports || &dvanced || Color M anagement !i Language || YWersion |

E‘gg |PB-m 1P Minipririter |

Locatian: | |

Comment;

b odel; FEB-A11P Miniprinter

Features

Color: Yes Faper available:
Double-zided: Mo a0 « 3276 mmla11PRM]
Staple: Mo

Speed: Unknown

b airiurn rezolution: 180 dpi

Frinting F'referenu:es...] | Frint Test Page ,I

] ] [ Cancel Apply

POSBANK®
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4-2 Installing on Windows VISTA / Server 2008 [ 7/ 8 /| Server 2012 [ 10

4-2-1 Via Serial Port or Bluetooth

1) Double-click the Windows Driver installation file.

2) Click Next.

POSBAMNEK PBAT1 Prime Windows Driver Installation x

Welcome to the InstallShield Wizard for POSBANK PB-A11 Prime Windows Driver

The InstallShield Wizard will install POSEANK PB-A11 Prime Windows Driver on your computer, To
continue, dick Mext.

— T <ws [ G | e,

3) Select a COM port to be used, and then click Next.

Port Type >
Serial Port / Bluetooth Serial Port

@®icomi (Ccoma O com?7  (Ocomio (O comi3 (O COMIG
Ocomz (Qcoms (QOcoms (OcoMiit (QcoMia (O COM17
Ocoma (Qcomse (QOcome (OcoMiz (QcoMis (O COMISs

USE Port
O USB

Parallel Port
QOLPT1 O LPTZ

Ethernet / Wireless LAN
() Ethernet / Wireless LAN
IP Address : | 192 . 168 . 1 . 1 |
Port Number : 9100

POSBANK®



A11 Prime
4) Click Yes to reboot the PC.

Restarting your computer can take effect.
Please restart your computer.

[Ves] | want to restart my computer now.
[Mo] | will restart rmy computer later,

Yes MNo

5) Open the printer properties window in the Windows OS.
¥ Control Panel — Hardware and Sound — Device and Printers.

6) In the Ports tab, click Configure Port.
% Skip this step in case of data communication using Bluetooth.

7) Match the communication settings to those of the printer. The communication settings of the
printer can be performed by conducting a self-test.
% Skip this step in case of data communication using Bluetooth.

COM1 Properties 7 >
Port Settings

Bits per second: | 115200 e
Data bits: | & v
Parity: | Mone w
Stop bits: |1 e
Flow control: | Hardware e

Bestore Defaults

Crs | (IR

POSBANK"
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8) Click Print Test Page and check printing status. Proper installation of the driver is indicated if

the test page is printed normally.

@ PB-A11P Miniprinter Properties

Security
General Sharing Ports

Language Version
Advanced Color Management

=9 PB-AT1P Miniprinter

Location;

Comment:

Features
Color Yes

Double-sided: Mo
Staple: Mo
Speed: Unknown

Maxirnum resclution: 180 dpi

Model: PE-ATTP Miniprinter

Paper available:

80 3276 mm[AT1PRM]

Print Test Page

Preferences...

oK Cancel Anply

POSBANK"



A11 Prime
4-2-2 Via USB Port

1) Double-click the Windows Driver installation file.

2) Click Next.

POSBAMEK PBATT Prirme Windows Driver Installation *

‘Welcome to the InstallShield Wizard for POSBANK PB-A11 Prime Windows Driver

The InstallShield Wizard will install POSBAME, PB-A 11 Prime Windows Driver on your computer, To
continue, didk Next.

InstaliBhreld 1 < Badk H

3) Select USB and then click Next.

Port Type et

Serial Port / Bluetooth Serial Port

) coM1 ) ComM4a ) COM7 (JJcoMio O CoM13 (O COMiG
() COM2 ) COM5 () COME comii (O coMida (O COM17
() COM3 ) CoMa () COM9 Cycomiz (O CcoMis (O COM1s8

USE Port

Parallel Port
OLepT1 O LPTZ

Ethernet / Wireless LAN
) Ethernet / Wireless LAN
IP Address : | 192 . 168 . 1 . 1 |
Port Number : 2100

MNext

POSBANK®



4) Click OK.

o Please turn-off the printer and then turn-on again.

OK

A11 Prime

5) Turn off the printer and then turn it on. The printer driver will be installed automatically.

6) Open the printer properties window in the Windows OS.

% Control Panel — Hardware and Sound —

Device and Printers.

7) Click Print Test Page and check printing status. Proper installation of the driver is indicated if

the test page is printed normally.

@ PB-A11P Miniprinter Properties

Security

Language Version

General Sharing Ports Advanced Color Management

=9 PB-AT1P Miniprinter

Location;

Comment:

Features

Color: Yes
Double-sided: Mo
Staple: Mo
Speed: Unknown

Maxirnum resclution: 180 dpi

Model: PE-ATTP Miniprinter

Paper available:

80 3276 mm[AT1PRM]

Preferences... Print Test Page

0K Cancel Applhy

POSBANK"



A11 Prime
4-2-3 Ethernet / Wireless LAN Port

1) Double-click the Windows Driver installation file.

2) Click Next.

POSBAMEK PBATT Prirme Windows Driver Installation

‘Welcome to the InstallShield Wizard for POSBANK PB-A11 Prime Windows Driver

izard will install POSBAMNK PB-A11 Prime Windows Driver on your computer, Ta
continue, didk Next.

It Shald 1 < Back H Cancel ]
3) Select Ethernet / Wireless LAN.
4) Enter the IP address and port number, and then click Next.
X

Port Type

Serial Port / Bluetooth Serial Port
() CoM1 () comM4 (O COM7 CcoMio O CoMiz (O COMis

() comz () CoMms (O coms (o coMil (O coMmid (O CoMmiz
() COM3 (O coms (O come (o coMiz (O coMmis (O COM1s

USB Port
JusB

Parallel Port
OLPT1 O LPT2

Ethernet / Wireless LAN
® Ethernet [ Wireless LAN

IP Address | 192 . 168 . 1 . 1 |

Port Number :

POSBANK®



5) Click Yes to reboot the PC.

Please restart your computer.

[Ves] | want to restart my computer now.
[Mo] | will restart rmy computer later,

Yes MNo

o Restarting your computer can take effect.

6) Open the printer properties window in the Windows OS.
% Control Panel — Hardware and Sound — Device and Printers.

7) In the Ports tab, click Configure Port....

8) Match the communication settings to those of the printer.
¥ The “"LPR” protocol is not supported with this printer.

Configure Standard TCP/IP Port Monitor

Port Settings

Port Name: | IP_192.168.1.1

Printer Mame or [P Address: | 192.168.1.1

Protocol

(® Raw (ILPR

Raw Settings

Port Mumber: G100

LPR Settings

LPR Byte Counting Enabled

] SMMP Status Enabled

public

Cancel

POSBANK"
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9) Click Print Test Page and check printing status. Proper installation of the driver is indicated if

the test page is printed normally.

@ PB-A11P Miniprinter Properties

Security
General Sharing Ports

Language Version
Advanced Color Management

=9 PB-AT1P Miniprinter

Location;

Comment:

Features
Color Yes

Double-sided: Mo
Staple: Mo
Speed: Unknown

Maxirnum resclution: 180 dpi

Model: PE-ATTP Miniprinter

Paper available:

80 3276 mm[AT1PRM]

Print Test Page

Preferences...

oK Cancel Anply

POSBANK"
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5. Windows Driver Settings

The following functions can be configured after installing the Windows driver.

5-1 Layout

Layout Documert Settings NV Image Barcode Dithering  Ltility

FPaper
Paper Size : B0 % 327E mm [
Paper Type: | Receipt w

Mumber of copies
Copies : : [1.255]

Crientation
(®) Portrait

() Landscape

Image Raotation

(® Momal

() Riotation by 90 Degrees [Cw]
() Ratation by 180 Degrees [Cw]
() Riotation by 270 Degrees [Cw]

[] Paper Reduction
Rate: 100%

Dizable reducing barcode

Enable reducing barcode

Crop Function
[ ] Top Crop Length o [ Pixel ]
] Battam Crop Length 0 [ Pixel ]

1) Open the Printer Properties window for the corresponding OS.
2) In the General tab, click Preferences (Printing Preferences).

3) Click the Layout tab.

POSBANK"



A11 Prime
5-1-1 Paper Size
Paper size of 80 x 3276 mm is selected by default, and the following sizes can be selected.
80 x 40 mm 80 x 3276 mm A4 210 X 297 Mm
If a custom paper size is required, click ™...” to add or update a custom paper size. Click Save after

specifying the paper width/length and a paper name. If the specified paper name already exists
on the system, you can update the paper width/length.

Paper Width : 25.4 mm (Min) ~ 220.0 mm (Max)
Paper Length  : 25.4 mm (Min) ~ 3276.0 mm (Max)
Faper Size
Delete |
Faper Mame : MWewPaperSize
Faper ‘width ; an.o mm [ 25.4 - 210.0]

-
Ll
-
L

Paper Length : 150.0 mm [ 25.4 - 3276.0]

}

You can choose the new paper size on the Paper Size combo-box after adding a paper size.

Layout Documert Settings NV Image Barcode  Ditherng  Lhility

Faper
Faper Size MHewPaperSize w
Paper Tupe: | Receipt o

Delete button : Deletes the paper size selected in the list.
Save button : Adds a new paper size or update the paper size selected in the list if the paper
name already exists on the system.

POSBANK"



A11 Prime
5-1-2 Paper Type

You can choose Receipt or Ticket as paper types. Receipt allows flexible paper length according
to the data length. Ticket print in fixed length even the print data is short. Default setting is
Receipt.

Receipt :  Receipt allows flexible paper length according to the data length.
Ticket :  Ticket printin fixed length even the print data is short.

Layout  Document Settings MV Image Barcode  Ditherng  Ltility

Paper
Paper Size 20 = 3276 mm w

Faper Type : R eceipt o
Mumber of cnpieJ Ticket ‘
Copies: | 1 |4[1.255]

Orientation
(®) Portrait

() Landscape

Image Rotation

(® Mormal

() Rotation by 90 Degrees [CWw]
() Rotation by 180 Degrees [Cw]
() Rotation by 270 Degrees [Cw]

[ ] Paper Reduction
Rate : 100%

Dizable reducing barcode

Enable reducing barcode

Crop Function
[ ] Top Crop Length 0 [ Pisel]
] Battam Crop Length I [ Pisel ]

POSBANK"



A11 Prime
5-1-3 Copies

Copies are printed by specifying the copy count. The copy count is set to 1 by default. Set this
value bigger than 1 to set the number of copies to print. The value should be within the range of 1
to 255.

5-1-4 Image Rotation

Image rotation is available for image data only. It means that rotation of device fonts or barcode
fonts is not supported.

5-1-5 Paper Reduction

Reduction function reduces the size of the print image to save print paper. If this function is
enabled and print-job data includes text data created by using a printer font, device fonts are
converted to True Type fonts to make them smaller. The barcode size also can be reduced by
selecting “Enable reducing barcode”.

5-1-6 Crop Function

This function crops the upper and lower end of the printing area by the specified number. It helps
reduce the margin at the top and bottom when there is excessive margin. The value should be
within the range of o to 255.

5-1-7 Orientation

Printing orientation can be set to Portrait (which is the default) or Landscape. It is not possible to
use device fonts and device barcodes in landscape.

Portrait  :Printingin the vertical direction.
Landscape : Printing in the horizontal direction.

POSBANK"



5-2 Document Settings

Layout Documert Settings NV Image Barcode Ditherng Uity

Send Command

Start Do

Start Page

End Page: |

EndDoc: |

Example : <1B4A00:

Cazh Drawer / Intemal Beep

[ ] Open befare printing 1 a0

[ ] Open befare printing 2 Gl

[ ] Open after printing #1 50

[ ] Open after printing #2 50

[ ] Beep sound before printing 50

] Beep zound after printing 50

Line Feed

Line-feeds after printing : III : [0.99]
FPaper Cut

i Page /Job: Mo Cut / Mo Cut
{®) Page / Job : Mo Cut / Partial Cut
) Page / Job : Partial Cut / Partial Cut

1) Open the Printer Properties window for the corresponding OS.

2) In the General tab, click Preferences (Printing Preferences).

3) Click the Document Settings tab.

POSBANK"
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5-2-1 Send Command

The Windows driver serves to receive the content for print from an application and send it to the
printer. The "Send Commands” function allows for the addition of desired commands at the start
or end of the print content.

Start Doc : Addition of command at the beginning of the document.
Start Page : Addition of command at the beginning of the page.

End Page : Addition of command at the end of the page.

End Doc :  Addition of command at the end of the document.

For more information about the hexadecimals that can be entered in “Start Doc”, “Start
Page”, "End Page” and “End Doc”, refer to the Commands Manual.

5-2-2 Cash Drawer [ Internal Beep

To open a cash-drawer before printing, tick *Open before printing #1” or “*Open before printing
#2".

To open a cash-drawer after printing, tick "Open after printing #1” or “Open after printing #2".

To make a beep sound when printing, tick “Beep sound before printing” or “Beep sound after
printing”.

5-2-3 Line Feed

It is possible to set the number of line feeds between o and 99 for adding blank lines at the end of
printing.

5-2-4 Paper Cut

Paper can be cut at the end of each page or each document (job).

Page/Job : No Cut / No Cut : Paper is not cut after printing.
Page/Job : No Cut / Partial Cut :  Paperis cut at the end of each document (Job).
Page/Job : Partial Cut / Partial Cut :  Paperis cut at the end of each page.

POSBANK"
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5-3 NV Image

Layout Document Settings NV Image Barcode Ditherng  Utility

MY Image Printing

Start Do Mare ~
Start Page Maone A
End Page: Mone e
End Do Mare w

MY Image Cormmand

®GS(L
(OFsp

1) Open the Printer Properties window for the corresponding OS.

2) In the General tab, click Preferences (Printing Preferences).

3) Click the NV Image tab.

The position to print NV image stored in the printer can be set at the beginning and/or end of the

document and beginning and end of each page. Also, there are two commands for NV Image
printing. Take care of selecting one of the two commands because NV images cannot be printed

depending on the selected command.

% NV graphics: “FS p”
% NV bitimage: “GS (L"”

Start Doc : Insert NV image at the top of the document.
Start Page : Insert NV image at the top of the page.
End Page : Insert NV image at the end of the page.
End Doc : Insert NV image at the end of the document.

POSBANK"



5-4 Barcode

Layout Document Settings MV Image Barcode | Dithering

10-Barcodes
Faont Mame Barcodel -
T}lpe : LIPC-& et
Froperties
20-Barcodes
Font Mame Z20-Codel e
Type : FOF417 e
Froperties

1) Open the Printer Properties window for the corresponding OS.
2) In the General tab, click Preferences (Printing Preferences).

3) Click the Barcode tab.

POSBANK"

Litility
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5-4-11d Barcodes

A11 Prime

Windows driver supports one-dimensional barcode fonts as shown in the following table.
Barcodes can be printed by using following font names.

Font Name Type (Symbology) Size (Point) Supported Characters
Barcodex UPC-A 20/40/60/80 Numeric: 0~9
Barcode2 UPC-E 20/40/60/80 Numeric: 0~9
Barcode3 JAN13 (EAN) 20/40/60/80 Numeric: 0~9
Barcodes JANS8 (EAN) 20/40/60/80 Numeric: 0~9

Numeric: 0~9
Barcodes Code3g 20/40/60/80 Symbols: $, +, -, .,/

Letters: A~Z
Barcode6 ITF 20/ 40/ 60/ 80 Numeric: 0~9

Numeric : 0~9
Barcodey Codabar 20/40/60/80 Symbols: $, +, -, ., /, :

Letters: A~D
Barcode8 Codeg3 20/40/60/80 ASCII CODE: oxoo ~ ox7F
Barcodeg Codea128 20/40/60/80 ASCII CODE: oxoo ~ ox7F

If you want to change the default value of 1d barcode properties, select a Font Name and Type of
one-dimensional barcode, and then click Properties. Click OK after changing the values of

properties.

Barcode Setting

Barcode

HRI Paszition

B attarn

HRI Fant
(®) Font &

() Font B

widh: | 3 |2 [2.5]
Height: [ 50 |4 [1.255]

Ok,

Cancel
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5-4-2 2d Barcodes

A11 Prime

Windows driver supports two-dimensional barcode fonts as shown in the following table.
Barcodes can be printed on the printer by using following font names.

Font Name Type (Symbology) Size (Point)
2D-Code1 PDF4a17 9.5
2D-Code2 QR Code 9.5

If you want to change the default value of 2d barcode properties, select a Font Name and Type of
two-dimensional barcode, and then click Properties. Click OK after changing the values of
properties for PDF417 or QR Code.

20-Code Setting

FDFA17

Calurnn : 0 [0.30]
Step : 0 [0,3.90]
idlth : 3 [2.8]
Height : 3 [2.8]
Error Carrection : Lesvel O

Set the procezzing of simplified POF41Y symbal

(R Code

Size : [1..8]
Model : todel 2 e
Error Correction ; Level L ~

]9

Cancel
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5-5 Dithering

Layout Document Settings NV Image Barcode Ditherng il

Dithering

Color

M onachnonme

©

(®) Mone

() Errar Diffusion
() Ordered Dither
() dwd Matrix

() Bwf Matrix

Brightness

Bright Drark,

1) Open the Printer Properties window for the corresponding OS.
2) In the General tab, click Preferences.
3) Click the Dithering tab.

This printer model is a black and white printing device including dithering function and
brightness level adjustment function to produce a sharper or softer image. The following
dithering algorithms can be selected.

-None

- Error Diffusion
- Ordered Dither
- 4x4 Matrix

- 8x8 Matrix
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5-6 Utility
Layout Document Settings MV Image Barcode Dithering

Unified POS Ltility
Unified POS Lltility

Extended Function

Special Font(Fontcontrold) Edit

Enable Journal

Journal Yiewer

Enable Test-k.ey Function

Text-F.ey Function

Enable Print Preview

The preview application runs before printing.

1) Open the Printer Properties window for the corresponding OS.
2) In the General tab, click Preferences (Printing Preferences).

3) Click the Utility tab.
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A11 Prime
5-6-1 Unified POS Utility
Refer to the Unified POS Utility manual contained in the CD for details.
5-6-2 Special Font Edit Utility
The purpose of FontControlA font is not for text printing. It is used to define the printer
command, assign the defined printer command to a specific ASCIl character, and send it to the
printer. The range of ASCIl code that the command can be assigned is from ox20 to ox7F, and the
command can be easily assigned using this utility.

1) Click Special Font Edit.

2) Select an ASClI code character and enter the print command. All values should be
entered in hexadecimal number format.

3) Click Apply and then click OK.

FontControlA Editor
Char Hex Command
20 1B 3D 00 ~
! 21 43 44 48 0A
- 22
# 23
£ 24
% 25
= 26
f 27 Char
{ 28 —
] 29
= 20
+ 2k
, . Hex
= 2d
= e
Eppl
! 2f ppLly
a 30
1 31
= i Delete
3 33
4 34
o 35
& 36 0K
7 37 W
Edit
1B 3D 00 Cancel
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5-6-3 Journal Viewer

Journal is a function to save a copy of printed receipts. Copies can be saved without using journal
printer with this function. Journal saves each printed document in a file and the saved file can be
viewed by using this utility.

1) Tick Enable Journal to run Journal Viewer, and then click Journal Viewer.

B Journal Viewer *

Preview

=
=
Windows Printer
Test Page
You have correctly installed your
e &

Al il

Date | Time | Path |
2016/06/09 16:54:42 C:\Windows\20160609_165442.jnl

Print Search ‘

2) Click Search to set search condition, and then enter Start Date and End Date.

3) Click OK to search the files created within the specified period.

lournal Viewer X

Search Options
Maonth Day Year
Start date: |3 /|8 [ | 2016

End date: 3 | 8 [ |2016

Cancel

4) Select the file to print from the list and click Print to send the data stored in the file to the
printer.

POSBANK"



A11 Prime
5-6-4 Text-Key Function
Text-Key Function is a utility to replace specific text (Text-Key) with other texts or graphic images,
and to add images to the bottom of receipts. This function can be used only when using device
fonts. It has no effect when using TTF fonts (True Type Fonts) or the data for Text-Key does not
exist on a Print-Job.

» How to replace Text-Key with other texts.

1) Tick Enable Text-Key Function and then click Text-Key Function.

[ TextKey Function X
Text Key List Image List
Add New Key Add New Image
OK Cancel

2) Click Add New Key, type a text to be used as Text-Key, and then click OK.

Enter a new text Key. >

TEXT KEY : POTATO

OK Cancel

[ TextKey Function X

Text Key List Image List

POTATO

Add New Key Add New Image

Configuration

Delete

0K Cancel
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3) If the Text-Key is selected, The Configuration button is enabled.

4) Click Configuration to enter a text, which is used to replace the selected Text-Key with the text
entered. For example, if you enter "APPLE" in the text box as below, the Text-key, “POTATO”

can be replaced with "APPLE".

Configuration for 'POTATO' X
Replacement
Image ID : |Nr:|r‘|e J
Text : | APPLE

Adding a image to the bottom of receipts

Image ID : |ND|‘|e J

Ok Cancel ‘

» How to replace Text-Key with a graphic image and to add it to the bottom of receipts.

1) This utility can also replace the selected Text-Key with a graphic image instead of texts and can
add a graphic image to the bottom of receipts. It is necessary to add images to the image list.

2) Click Add New Image to browse for an image to add to the list.

% Fileto load >

Look in: | [&=] Pictures j da % Ef~

Camera Rell [&d] 5_Penguins
Saved Pictures

|&d] 1_Cat

(&l 2_Elephant

|&] 3_Hippo

(& 4_Lion

< >

File name: |5_Penguins Open

Files of type: | BMP Files (" EMP) | Cancel

[ Open as read-only
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3) Enter a unique name to be added, adjust the brightness, select a dithering type, and then click

OK. Repeat 2 to 3 step to add up to as much as you want.

TextKey Function

Image Identifier

Transformed Image

Original Image

5_Penguins

Brightness Dithering

- I * Type-1 " Type-3
Bright Dark © Type-2 " Type-4
Preview

Cancel

~ TextKey Function

Text Key List Image List

Add New Key Add New Image
Configuration Delete
Delete

oK

Cancel

4) Select a Text-Key in the Text-Key list, and then click Configuration.
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5) To replace the selected Text-Key with a graphic image, select one of the available identifier via
the combo box under “Replacement” label. There are two replacement functions but only

one of the two is available.

Configuration for 'POTATO'

-Replacement

-Replacement

Image ID : |5_Penguins

Image 1ID :

Text : |

-Adding a image to the bottom of receipts

Text :

Image ID : |4_Li0ﬂ

[ o |

B

Image ID :

Cancel |

Configuration for 'POTATO"

-Adding a image to the bottom of receipts

| 5_Penguins

4 Lion j

MNone
5_Penguins

6) In order to print a graphic image to the bottom of receipts, select one of the available identifier
via the combo box under "Adding a image to the bottom of receipts” label. The graphic
image for the selected identifier only will be printed if the data for the selected Text-Key were

found on a Print-Job.
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5-6-5 Print Preview

A11 Prime

This application with a preview of a print-job runs, and windows driver does not directly send
print-job data to the printer when enabled by clicking "Enable Print Preview”. Print-job data can
only be sent to the printer in the application. The actual output of preview image processed by

the application might look a little different.

1) Tick Enable Print Preview to make Windows Driver ready for running the application.

! Print Preview

*

¥ Always on Top

Test Page

Windows Printer

PB-A1TMiniprinter on
DESKTOP-542TF5(.

PRINTER PROPERTIES
Submitted Time:

Date:
User Name:;

Computer Name:
Prirter Name:

Al

You have cerrectly installed your

451
P
6/3
DE!
xB64
DE!
PB-

KT

i

El
0

2) When print-job data are created via Windows Driver, the application runs, and then loads the

data to draw the expected output on screen.

3) Click Print if you want to print, or click Close to exit the application.
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5-7 Bidirectional Communication

A11 Prime

& PB-A11P Miniprinter Properties

Securty
General

=

Sharing

PE-A11P Miniprinter

checked port.

Ports

Language

Print to the following port(s). Documents will print to the first free

Advanced

Wersion
Color Management

[“]EEnable bidirectional support:

] Enable printer pooling

Port Description Printer 2~

[]LPT2: Printer Port

[]LPT%: Frinter Port

[] COM2:  Serial Port

[] COM3:  Serial Port

[]comM4:  Serial Port

COM1:  Serial Port PE-A11P Miniprinter

[] FILE: Print to File W
Add Port... Delete Port Configure Port...

Cancel

=
o
=

1) Open the Printer Properties window for the corresponding OS.

2) Click Ports tab.

It is necessary to tick Enable bidirectional support to get status from the printer. Sample codes
contained in the CD can help you get more status information than the status information that

OS supplies as standard way.

Printer status that OS support

Printer status that OS does not support

ONLINE/OFFLINE
COVER OPEN/CLOSE
PAPER EMPTY

NEAR END PAPER
CASH DRAWER OPEN/CLOSE
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6. Windows Driver Specifications

6-1 Font

A11 Prime

This Windows driver supports various fonts in the following table. Printing using these fonts
is faster than using Windows fonts provided by the operating system.

Printer Font (Device Fonts) Name

Font Size (dot)

Font Size (point)

FontAixa FontAixa[Ext.] FontAaxi[255] FontAax1(12x24) 9.5
FontAix2 FontA1x2[Ext.] FontA1x2[255] FontA1x2(12x48) 19
FontA2x1 FontA2xa[Ext.] FontA2xi[255] FontA2x1(24x24) 9.5
FontA2x2 FontA2x2[Ext.] FontA2x2[255] FontA2x2(24%48) 19
FontA2x4 FontA2x4[Ext.] FontA2x4[255] FontA2x4(24x96) 38.5
FontA4x2 FontA4x2[Ext.] FontA4x2[255] FontA4x2(48x48) 19
FontA4x4 FontA4x4[Ext.] FontA4x4[255] FontA4x4(48x96) 38.5
FontA4x8 FontA4x8[Ext.] FontA4x8[255] FontA4x8(48x192) 77
FontA8x4 FontA8x4[Ext.] FontA8x4[255] FontA8x4(96x96) 38.5
FontA8x8 FontA8x8[Ext.] FontA8x8[255] FontA8x8(96x192) 77
FontBixa FontBaxa[Ext.] FontBixa[255] FontBixa(9xi17) 7
FontBax2 FontBax2[Ext.] FontB1x2[255] FontBax2(9x34) 13.5
FontB2x1 FontB2xa[Ext.] FontB2x1[255] FontB2x1(18x17) 7
FontB2x2 FontB2x2[Ext.] FontB2x2[255] FontB2x2(18x34) 13.5
FontB2x4 FontB2x4[Ext.] FontB2x4[255] FontB2x4(18x68) 27
FontB4x2 FontB4x2[Ext.] FontB4x2[255] FontB4x2(36x34) 13.5
FontB4x4 FontB4x4[Ext.] FontB4x4[255] FontB4x4(36x68) 27
FontB4x8 FontB4x8[Ext.] FontB4x8[255] FontB4x8(36x136) 54.5
FontB8x4 FontB8x4[Ext.] FontB8x4[255] FontB8x4(72x68) 27
FontB8x8 FontB8x8[Ext.] FontB8x8[255] FontB8x8(72x136) 54.5
FontCaxa FontCaxa[Ext.] FontCaxi[255] FontCaxi(9x24) 9.5
FontCax2 FontCax2[Ext.] FontCax2[255] FontCax2(9x48) 19
FontCaxa FontCaxa[Ext.] FontC2xa[255] FontC2x1(18x24) 9.5
FontCax2 FontCax2[Ext.] FontC2x2[255] FontC2x2(18x48) 19
FontC2x4 FontCax4[Ext.] FontC2x4[255] FontC2x4(18x96) 38.5
FontCs4x2 FontCsx2[Ext.] FontC4x2[255] FontCsx2(36x48) 19
FontCsx4 FontCsx4[Ext.] FontCs4x4[255] FontCsx4(36x96) 38.5
FontC4x8 FontCs4x8[Ext.] FontC4x8[255] FontC4x8(36x192) 77
FontC8x4 FontC8x4[Ext.] FontC8x4[255] FontC8x4(72x96) 38.5
FontC8x8 FontC8x8[Ext.] FontC8x8[255] FontC8x8(72x192) 77
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Printer Fonts are defined as follows.

1) FontA1x2
- ANSI Character code support (Code Page 1252)
- Font size (dot): 12 x 48 (Double height)
- Font size (point): 19

2) FontAax2 [Ext.]
- IBM expansion Character code support (Code Page 437)
- Font size (dot): 12 x 48 (Double height)
- Font size (point): 19

3) FontAix2 [255]
- Buyer exclusive code support
- Font size (dot): 12 x 48 (Double height)
- Font size (point): 19

POSBANK"
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6-2 Special functions
This Windows driver supports the special functions as shown in the following table.

Select FontControl font first and use the characters in the table to use the special functions. Take
care as this function is not for printing general texts.

Character Special Function
Prints HT (o x 09)
Prints LF (o x 0A)
Prints CR (o x oD)
Open Drawer 2 (5oms drive pulse width)
Open Drawer 2 (100ms drive pulse width)
Open Drawer 2 (150ms drive pulse width)
Open Drawer 2 (200ms drive pulse width)
Open Drawer 2 (250ms drive pulse width)

Open Drawer 2 without paper feeding (5soms driver pulse width)
Cut Receipt (partial cut) without paper feeding
Prints the NV Image saved in the oo address (double-size)
Prints the NV Image saved in the o1 address (double-size)
Prints the NV Image saved in the 02 address (double-size)
Prints the NV Image saved in the 03 address (double-size)
Prints the NV Image saved in the o4 address (double-size)
Does not add HRI characters to the barcode
Adds HRI characters in Font A above the barcode
Adds HRI characters in Font A below the barcode
Adds HRI characters in Font B above the barcode
Adds HRI characters in Font B below the barcode
Turns white/black reverse printing mode on
Turns white/black reverse printing mode off
Aligns text to the left
Aligns text to the center
Aligns text to the right
Open Drawer 1 (5oms drive pulse width)

Open Drawer 1 (100ms drive pulse width)

Open Drawer 1 (150ms drive pulse width)

Open Drawer 1 (200ms drive pulse width)

Open Drawer 1 (250ms drive pulse width)

Open Drawer 1 without paper feeding (5oms driver pulse width)
Prints the NV bitmap saved in the oo address
Prints the NV bitmap saved in the 01 address
Prints the NV bitmap saved in the 02 address
Prints the NV bitmap saved in the 03 address
Prints the NV bitmap saved in the o4 address
Cut Receipt (partial cut)

Prints the NV Image saved in the oo address
Prints the NV Image saved in the 01 address
Prints the NV Image saved in the 02 address

||| |R|—|—|T|a|m|m[O|n|w|>|x|s|<|c|l+|v|s|la |3 |—|~[—|—|l@|+n|o|a|o|o|o [N ||
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Prints the NV Image saved in the 03 address

Prints the NV Image saved in the o4 address

Prints the NV bitmap saved in the oo address (double-size)

Prints the NV bitmap saved in the 01 address (double-size)

>|——|<|C

Prints the NV bitmap saved in the 02 address (double-size)

Prints the NV bitmap saved in the 03 address (double-size)

Prints the NV bitmap saved in the o4 address (double-size)

1) Example

Select FontControl font and send 6 for "LF” (Line Feed) operation.
(instead of printing character “6").

2) FontControl font functions.

Font Name Special Functions Font Size (point/dot)
Open Drawer 1/2
Cut receipt
Cut receipt(without paper feeding)
FontControl Justification (Left/Center/Right) (9.5/12x24)

Output HT, Output LF, Output CR
Barcode Printing
Print NV Graphic Data
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7. Use of Windows Driver
7-1 Use of Visual Basic

This section contains example codes to control the printer using Windows driver with Visual Basic.
Sample programs are included in the CD.

7-1-1 Windows Driver Selection

The following example code explains how to select “PB-11P Miniprinter” Windows driver.

For Each prnPrinter In Printers

If prnPrinter.DeviceName = “PB-11P Miniprinter” Then

Set Printer = prnPrinter
Exit For
End If

Next

7-1-2 Text Printing

The following example code explains how to print texts using Windows Fonts and Device Fonts.

‘Print in Windows font
Printer.FontSize =g
Printer.FontName = “Arial”
Printer.Print “Arial Test”

‘Print in printer font
Printer.FontSize = 9.5
Printer.FontName = "FontAaxa”
Printer.Print "FontAaxa Font”

Printer.EndDoc
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7-1-3 Barcode Printing

The following example code explains how to print the barcode (JAN8 (EAN)).

'Print Bar Code.
Printer.FontSize = 20

Printer.FontName = "Barcodes"
Printer.Print "1234567"

Printer.EndDoc

The following example code explains how to print the 2D barcode (PDF417).

'Print Two-dimensional Codes.
Printer.FontSize = 9.5

Printer.FontName ="2D-Code1"
Printer.Print "Print Test PDF 417"

Printer.EndDoc
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7-2 Use of WordPad
7-2-1 WordPad Environment Settings

Launch WordPad, set the printing related options as follows, and test the printer with WordPad.

- Select printer
Select “Print” from the “File” menu, and select the printer (PB-11P Miniprinter).

- Set paper size, orientation, margin, etc.
Select the “"Page Setting” from “File” menu, and set paper size, orientation, and margin.

7-2-2 Text Printing

Print the text from WordPad using the Windows driver of the printer.

File Edit Wiew Insert Faormat Help

DeE && # - e« B

iFu:unt.ﬁ.1:-:1 v| |E|.5 v| |Westem v B 7 U 5 |%|§ = iz
L e e L R B "y

Fonthlxl Dewvice Font

For Help, press F1 MM

1) Select the font from the font selection box (FontAixz1).
2) Select the point size from the point selection box (9.5).
3) Enter the text to print.

4) Click the Print icon in the toolbar to print the text.
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